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1. Setting the Scene

Welcome back to the beautiful, coastal Navarro River Watershed (photo credit: Clinton Steeds). Using ArcGIS
Pro, we will determine the probable nesting locations of the rare marbled murrelet (Brachyramphus marmoratus)
in the Navarro River watershed. The marbled murrelet is a secretive bird, but it is thought to make its nests in old
growth forests on steep ( > 20 degrees), west-facing slopes within 35 km of the ocean at or around the 150m
elevation.

This type of analysis is a common one, called a suitability analysis. It is used to help us answer the question of
what locations meet a set of conditions.

Summary of Procedures
Create a new Project and add a digital elevation model. We'll generate hillshade, slope and aspect grids; load a
coast distance raster and a grid of old growth forest patches.

Query grids to determine probable nesting locations based on outlined habitat parameters.
Display resulting habitat patches draped over the DEM with hillshade as a brightness theme and elevation

contours overlaid.
Review
1. We can set analysis options in environment settings
2. Suitability analyses are the process of determining what locations meet a set of criteria.
3. Symbology is the representation of data on a map
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2. Create a new ArcGIS Pro Project

To start, create a new map project in the default location. Name the project suitability_analysis_lab.

2.1 Move the project data

As before, extract the downloaded geodatabase and move it into your project folder for easy and quick access
within ArcGIS. In this case, move the folder named suitability_analysis.gdb into the suitability_analysis_lab folder.
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3. Add the Digital Elevation Model to the map

Once we have our project open and have moved the data into our project folder, we'll add some data to our map.
You can use the Add Data button if you like, and this step will use an alternate method through the Catalog pane.
1. In the Project tab of the Catalog pane, expand the Folders section and the suitability_analysis_lab project
folder
2. Expand the navarro_data.gdb geodatabase
3. Click and drag navarro_dem_10m onto the map

When adding data and looking inside of folders and geodatabases, note the icon differences – can you tell the
difference between the data types it is indicating?
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3.1 Look at the raster information

The digital elevation model we just added is a raster, sometimes called a grid, stored in our geodatabase. A
digital elevation model does not require any special data structures beyond that, and the only thing that
differentiates a digital elevation model from other raster data is that we know the values in the raster refer to
elevations - that is, it's a conceptual distinction and not a technological one.

Take a look at the layer properties to learn a bit more about the parameters of this raster.
1. Right click on the layer and go to Properties
2. In the Layer Properties dialog that pops up, click to the Source section. Expand the different sections within it
and look at the information. What's the cell size and what do you think its units are? What do the columns and
rows mean in this context?

This particular DEM is a 10 meter DEM, which means each cell in the grid is 10 meters wide on each side
(approximately - they're typically captured as geographic/angle-based coordinates instead of planar coordinates,
which means the sides could actually be slightly different lengths throughout the grid based on latitude and the
X and Y sides could differ - that's a distinction you don't need to memorize, but just be aware of - for our
purposes, it's safe to think of it as a 10 meter DEM). This was a very high resolution DEM at the time it was
captured, and is still high resolution for common data throughout the world, where 30 meter DEMs are widely
available. When we think of what this means, that we only have one elevation value for a 10 meter by 10 meter
area of ground, this is relatively coarse in many ways, depending on your analysis. For a landscape-scale project
like we're doing, it's *probably* fine, but as we go through this tutorial, consider the ways that this resolution of
DEM could limit our analysis or introduce potential error or where gaining local knowledge would be an
important verification of our analysis.

Today, DEMs of 3 meters or even 1 meter aren't uncommon in the United States, and low cost drones are making
DEMs with centimeter scale and accuracy for small localized areas possible for projects that need them - for
that, consider the possible challenges that a DEM of that scale would create for landscape-scale analyses.

Before closing the dialog, I also recommend looking through the other parts of the properties dialog in the left
column and familiarizing yourself with what's available here. If you're coming from ArcMap or QGIS, there's far
less information in here that you need to work with than before. It's mostly in ribbons and panes now. When
you're done looking around, close the dialog box.
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3.2 Change the DEM symbology

Now let's update the symbology. The default black to white is fine, but we can use something more familiar.

Open up the symbology pane for the layer (remember to have it selected in the Contents pane while using the
Symbology pane). By default, it shows a symbology type of Stretch, which is what we want, so we just need to
change the Color scheme, often called a color ramp.
1. Click the dropown for color scheme
2. Scroll down until you see Elevation #1. If it's hard to find, check the Show names box at the bottom to see the
ramps by name instead of color.
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4. Set Elevation Symbology

First, take a look at the colors and see if you can get a decent sense of what this basin might look like. Consider
that long valley running northwest to southeast. Do you think that's a valley or a distortion of our perception
caused by the color ramp?

As another note, there are two types of color ramps I typically avoid, and this is one of those types:
Color ramps that have many different sets of gradients within them. I'd usually say 2 gradients maximum (as

in, fade from green to yellow and yellow to brown only) - beyond that, it's hard for the viewer to get a sense for
what the data means. Elevation data is a bit different since it tends to behave more continuously than some
other data sources and people have experience looking at these color ramps. But for a hard to comprehend
example, look at some of the combined rain/sleet/snow forecast or hurricane intensity maps where the colors
actually *repeat* within them. Very hard for a person not experienced in that area to interpret. In this case, do
you think this elevation coloring is interpretable? Looking at this map, do you feel like you can intuitively
understand which locations are high elevation and which ones are low elevation? Do you have any critiques of
the use of this color ramp in this context?

Color ramps that use red and green for important colors. For two reasons - first, red and green are widely
interpreted as good and bad, so even if you aren't trying to suggest one is good or bad, it is subconsciously
conveying that to many people. Second, they're an accessibility issue - red/green colorblindness, where
someone can't distinguish between a red or green of the same saturation, is the most common type of
colorblindness - red to green color ramps are challenging or impossible for people with this type of
colorblindness to interpret. It's easy to avoid them (https://colorbrewer2.org from famous cartographer Cynthia
Brewer is the resource to start with if you want to make accessible maps that are easy for everyone to interpret)
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5. Make a histogram of elevation values

Now let's take the elevation out of the spatial realm and get a sense for the overall spread of elevation values
within the watershed by making a chart of all the values, called a histogram.

Histograms are useful because they tell us about the frequency of each value or ranges of values - they count up
how many times in a dataset values within a given range occur, and then plot those values as bars for all
possible ranges of values - this will make sense in a moment.
1. In the Raster Layer section of the ribbon, click the Data tab
2. Click the Create Chart button
3. Choose Histogram
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5.1 Charting tools

We'll end up with an empty chart area at the bottom and a pane on the right for Chart Properties. We won't see an
actual chart until we select what the data source for the values in the chart should be.

1. From the Number dropdown in the Variable section, choose VALUE. VALUE is a special variable name for
raster data that indicates that rather than using a field, it should use the cell values across the whole raster.
2. A chart should already pop up, so examine it briefly. What is the most common value? Is it surrounded by
other common values, or does it stick out on its own? Would you expect this distribution of elevations based on
what you see spatially?
3. Let's change the chart a bit. Adjust the Bins slider all the way to the right. Move it around a bit and observer
the impacts on the histogram. Does the number of bins change the interpretation of the frequency of each
elevation or the overall interpretation?
4. Turn on the mean, median, and standard deviation lines to help us better understand the central values and
spread in this elevation distribution. Is this DEM normally distributed (note the checkbox for comparing to a
normal distribution)?
5. Note that charts can be exported to images elsewhere (a really fast way to get numeric information from
otherwise-spatial data) and also that this chart is permanently in our Contents pane now - that is, we can close it
and it's still saved in the project and we can open it again by double clicking on it in the contents. Feel free to
modify the chart and then close it when you're done.
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6. Set Environments for analysis

OK, now let's dive into a bit of analysis. To do that, let's set some Environment Settings, often simply called
Environments.

Environments are variables that control the context of analysis tools and may affect how they behave. We can
think of them almost like applications settings, but they impact the results of our analysis rather than controlling
how something looks on our screen. In most cases, ArcGIS does the smart thing with environment settings by
default, and we don't need to make these changes, but it's always good to do to make sure, and it's a good
illustration of what's happening behind the scenes for us.

1. To get started, switch to the Analysis ribbon
2. Click the Environments button in the Geoprocessing ribbon.
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6.1 Set your Environments

The Environment Settings window will pop up. We're going to set five separate values here - we'll choose them all
from dropdowns, though after we choose, ArcGIS might reinterpret it and show something different - this is
normal - it reads data based on our selection, interprets it, and shows us the values we're using.

Most of the settings we're going to change will just ensure proper alignment of our output data with our input
data - depending on the projection, cell size, etc, raster cells can slightly misalign. These settings help make sure
everything lines up. Again, ArcGIS would choose smart defaults for these, based on the input data, in most
cases.
1. We're going to set Output coordinates to be the same as navarro_dem_10m (not shown in picture - it's higher
up in the box)
2. Set the Extent to be Same as layer navarro_dem_10m (also not shown)
3. Set the snap raster to navarro_dem_10m (what do you think this does? It has to do with cell alignment - note
the help icons next to each value when you hover over it)
4. Set the cell size to be Same as layer navarro_dem_10m - this ensures that the output raster from any
geoprocessing operation matches this one, even if we use an input raster that has a different cell-size
5. and finally, set the Mask to navarro_dem_10m - this setting basically says that any geoprocessing result where
the value is located in a place that navarro_dem_10m has no value should also not have a value (or in other
words, it should only keep values where we have the elevation data, even if other inputs have data in other
locations).
What other environment settings might you set? Look around at what's available to get a sense for them for
when you need them. Note also that ArcGIS help specifies for each geoprocessing tool the environment settings
that affect them.
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7. Calculate Slope

OK, now that we've set up our analysis environment, it's time to generate some data that will help in our analysis.
We'll start with slope.

Recall that the marbled murrelet creates its nests on steep terrain ( > 20 degrees) - so we'll need to incorporate
that into our analysis. To begin this process, we'll make a slope raster from our DEM. Conceptually, if you know
the elevations of each location, you can determine the slope to neighboring locations - that's what the slope
geoprocessing tool does.

Locate the Slope tool either by using the Search panel in the Geoprocessing pane, or by finding it in the
Toolboxes tab under Spatial Analyst Tools > Surface > Slope.

1. If the Geoprocessing tab isn't currently available in the right pane, you can open it from the Tools button on the
Analysis ribbon.
2. Then search for the word "Slope"
3. I chose the second result since it's the version in the Spatial Analyst Tools toolbox, but it's functionally the
same as the first one. Click on it to open the tool.
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7.1

1. We'll use our DEM as our input raster
2. Give the Output raster the name navarro_slope in the same geodatabase it wants to save the outputs in by
default.
3. For the Output measurement, what option should we select? Check the problem statement to determine what
to use.
4. Click Run to execute the tool.

Once the slope raster is generated, we'll get a new raster in our Contents pane and drawn on our map.
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7.2 Pixelated slope!

Examine the slope of the Navarro DEM. Does it seem representative of a coastal watershed?

After looking around a little bit, zoom in until you can see the pixel boundaries. In many cases, it can be useful to
see these since it helps show us the limits of our data, but sometimes it's less useful cartographically. We can
change how it renders though so it's less pixelated when we zoom in.
1. Choose the Appearance ribbon in the Raster Layer section
2. Click the Resampling Type button and choose Cubic which smoothly interpolates the values on our screen at a
higher resolution than the input data.
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7.3 Cubic resampling

Take a look at the updated raster when you zoom in. Note that this isn't *real* new data - we wouldn't typically
use this kind of interpolation as an analysis input, but it can be useful for visualizing still.
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7.4 What's this?

What do you think is going on here where we get these bands of data and large flat areas with a higher slope
location in between? Take a look at the digital elevation model in the same spots. Do you have any thoughts
about what could be going on? Making a histogram of the slope raster could also help in understanding this
(make sure that when you click to create the histogram that the slope raster is selected in the Contents pane, or
right click on the slope layer itself to create the chart) - are there quite a lot of zero slope pixels? You may need to
change the number of bins again to answer that question. Do we think this is real terracing?

My guess for what's happening here is that these areas have a relatively constant low slope, but that the sensor
that collected the DEM data didn't have sufficient vertical resolution to distinguish between an elevation of 1.1
meter and 1.2 meters (for example). So minor variations between cells in the raster disappear and then it
calculates no slope. And then eventually, as me move along the raster, we get a spot that has enough elevation
difference to register as a different elevation value, which produces a slope value as well. Be on the lookout for
data artifacts!

If you didn't already do so, make a histogram of the slope raster (again, make sure that when you click to create
the histogram that the slope raster is selected in the Contents pane) and examine it in the context of the marbled
murrelet's criteria for nesting (on the first page). Does it seem like there will be many potential sites based on the
slope data?
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8. Make an aspect raster now

Our next criterion is that the marbled murrelet prefers south facing slopes. To get directionality of slope, we'll use
a different tool, the Aspect tool. Search for it in the geoprocessing tool box and open it up.
1. Use your DEM as the input raster
2. Name the Output Raster "navarro_aspect"
3. Leave the method as the default (hover over it to see an explanation if you'd like) and then click Run.
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8.1 Aspect

I love aspect rasters and their default visualization. By default, I feel like they're the Andy Warhol paintings of GIS.

Examine the symbology legend associated with the new layer. What are the values depicting?
What value is used for flat areas? Is there anything peculiar about the output? Make flat areas black and examine
the output up close.
Do we see the same terracing here that we saw in the slope grid? What about in the DEM?

After inspecting the values a bit, make a histogram chart of the aspect raster as well:
What pattern do you notice?
Can you take a mean value of aspect?
Is there a way to handle these data in a linear fashion?

Also, start thinking of what how we might filter an aspect raster for south facing slopes - do we just include the
cells that are directly west, or do we also include southwest and northwest to some extent?
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9. Make a hillshade

Now let's make a hillshade. We already have one in the background in the form of our basemap, but I like working
with local data when I can, and we'll have more control over this display. You can do this with geoprocessing if
you like (can you find the tool?), but we'll do it a different way this time, with a Raster Function.

Raster functions have existed for a while, but are much more accessible in ArcGIS Pro than in many other GIS
packages. In short, a raster function can perform the same calculations as we've been doing for slope and
aspect, but instead of saving out a new dataset, which can become a data management issue at times (and we
don't always need to store our intermediate data if we can recreate it in a documented fashion), it just calculates
it from the source all the time. When it's showing you the data on your screen, it calculates for your current view
extent and resolution, making it something it can do rapidly since it isn't calculating it for the entire dataset. They
can be used in geoprocessing too, at which point the whole dataset will be calculated, if needed.
1. Open the Analysis ribbon
2. Click the Raster Functions button
3. And then click the Raster Functions option in the dropdown.
4. Scroll down and expand the Surface section, where you'll see some familiar items. Click the Hillshade option.
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9.1 It looks like a geoprocessing tool and smells like a geoprocessing
tool...

So, this will look like a geoprocessing tool - hooray for user interface consistency! But it's not a geoprocessing
tool. You'll provide a set of inputs still and get an output, but instead of having a stored output location you
provide, you'll click the Create new layer button at the bottom when you're ready (not yet).

1. For a hillshade calculation, we start with our DEM, so provide that as the input for the Raster parameter - you
can select it from the dropdown
2. For Hillshade Type select Multidirectional - these are truly beautiful - older hillshades just look ugly to me in
comparison. Feel free to try both options here though.
3. Leave the others at their defaults and then click Create new layer
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9.2 The multidirectional hillshade

A new layer will show up in your table of contents and on your map and will redraw as you zoom and pan. Take a
look around for a little bit - how does it look compared with the basemap?
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10. Draping the DEM over the hillshade

Now we'll put some data on top of our hillshade and use the hillshade to enhance it. We typically call this
process draping like a tablecloth - with the analogy that one layer will appear to sit on another layer and hug
close to it. To do this, we'll move the DEM on top of the hillshade and make it semitransparent
1. Either turn off (uncheck) or move anything above the DEM and hillshade lower in your contents pane.
2. Make sure the DEM is above the hillshade in your contents pane so that it draws on top. At this point, your
hillshade will be obscured.
3. Make sure the DEM is selected in your contents pane and switch to the Appearance ribbon. Change
transparency to 30%. You should see an effect almost as if the hillshade is now colored by elevation.

A Suitability Analysis: Spatial Analyst, Raster Data, and DEMs - Copyright Nick Santos and UC Davis Continuing and
Professional Education 2021

Page 24



  A Suitability Analysis: Spatial Analyst, Raster Data, and DEMs

10.1 Draping: Part 2

This is already a pretty nice way, but a new feature in ArcGIS Pro lets us enhance these kinds of effects
substantially, doing things that pro cartographers have previously had to take to other GIS packages or into
graphics packages like Adobe Illustrator to accomplish. Beneath the transparency slider, there's an option for
Layer Blend which controls how the software mixes the two datasets' pixels when they draw on top of each
other.

1. Choose a few items from the dropdown and see how they behave. Eventually try the "Multiply" option and
leave it there.

Multiply makes the data layer on top look truly "baked on", as if we had a hillshade that just happened to have the
colors of the DEM already in the data.

Also note that layer blend modes don't require transparency. When you set a blend mode, ArcGIS blends the layer
down on top of the one below it regardless. The transparency we set lightens the layer up a bit and makes it work
without changing the blend mode, if we wanted. I liked the lighter effect of it with the transparency, but set it to
your preference.
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10.2 Compare it

To see the effect we just created in action, we could just turn the DEM on and off a few times to compare, or we
could use the Swipe tool which lets us compare rasters that are on top of each other.
1. Click the Swipe tool on the Appearance tab - make sure that navarro_dem_10m is selected in your contents
pane - that controls your swipe.
2. Click and hold on your map in the top half and drag your mouse up and down to see a comparison that
changes as you move your mouse. You could also click on the left or right to have a vertical comparison.
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11. Adding more data

For the marbled murrelet habitat, we also need to know the distance from the coast and old growth locations.
We've provided these for you for the purposes of this lab - they're in the navarro_data geodatabase.

You can add the data any way you like, but we'll do it from the catalog pane.
1. Expand the Catalog pane
2. Expand the Folders and suitability_analysis_lab tree items so you can see their contents
3. Expand the navarro_data geodatabase
4. click and drag navarro_coast_distance and navarro_oldgrowth onto your map to add them.

Take a moment to look at the data - what is the data type, what do you think it's conveying?
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12. Data Management

We already have quite a few layers, so let's do some document management work - Even though we generated
many of the items we've already produced here, they're all *inputs* to our suitability analysis and we're about to
generate a lot of intermediate analysis products based on suitability criteria, and results. So let's create some
layer groups to keep things organized.

1. Click on the top item in your Contents pane
2. Hold down the shift key and then click the bottom item above the Topographic basemap
3. Right click and then choose Group in the context menu.

You'll see all the items are now nested under a layer named "New Group Layer" - rename this group layer as
"Inputs". Play around a bit with turning items on and off, including the group layer. Note that each layer can still
be turned on and off on its own, but that turning off the group layer hides them all, regardless of their own status.
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12.1
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13. Running the Suitability Analysis

Next up, we start checking for suitability. For this, we'll use a new tool (to us, it's quite an old tool, really) called
Raster Calculator.

If I think of the most basic things I might want to do with GIS, it's that I want to overlay data and run calculations
on overlapping areas. In the vector world, it's the Overlay toolset that we've used for Spatial Joins and
Intersections. In the raster world, the Raster Calculator is our tool. Much of what it does can be done with a
combination of many standalone tools, but raster calculator lets us take overlapping pixels and run arbitrary
calculations on them. At times it might feel a little like SQL expressions used for selections and subsetting or a
little like Python expressions used for field calculations, but it's not really either one. It's its own beast.

Raster calculator lets us identify locations that meet specific conditions, making it even more like SQL subsetting
and selection expressions. But instead of selecting pixels, we get an output grid telling us which pixels met the
conditions and which ones didn't. We do this with boolean logic, which ArcGIS calls Map Algebra. Boolean logic
lets us write expressions with conditions that result in a value of either True or False. ArcGIS evaluates these
expressions for each pixel (such as, does the pixel face west? True/False) and then returns a new raster with the
value of 1 for True and 0 for False, allowing us to feed these rasters into further mathematical or processing
operations.

Let's go see it in action. Open up the geoprocessing pane and search for Raster Calculator. Choose the option
that's in the Spatial Analyst Tools toolbox.
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13.1 Calculate Slope Suitability

Let's start with slope since it's the easiest to work with. We need a way to pull the locations from our slope raster
that meet the marbled murrelet's slope conditions of being greater than 20 degrees slope.

Now let's construct a query. Before you do, I recommend expanding the geoprocessing pane for working in
Raster Calculator - the two column setup makes it easier to work with this way - you can hover your mouse over
its left edge until your cursor changes to the double-arrow drag handle, then click and drag to expand.

1. Double click on Inputs\navarro_slope in the Rasters column to add it to our expression (you could also just
type it, but then you have to get the syntax and quoting right). Double clicking it here takes care of any necessary
quoting based upon the workspace the rasters are stored in (geodatabase, folder, etc).
2. Click into the expression box yourself and type > 20

Your final expression will look like in the screenshot and will read:

"Inputs\navarro_slope" > 20 

Consider what this means - we're saying "for every pixel in navarro_slope check if the value is greater than 20. If it
is, place a value of 1 in the output for that pixel. Otherwise, use a value of 0". Remember also that we set our
analysis mask environment, so areas outside of the watershed but within the rectangular extent of the
watershed will get null values instead of 0.

Save your raster output in your default geodatabase. Name it navarro_suitable_slope_gt20 (3). I prefer descriptive
names like this even though they're long because for intermediate products it makes it easier to understand what
a data layer is, even if I'm not stopping to add metadata to everything. I tend to construct a name like this as
projectprefix_itemname_specifics - so in this case I read it as part of the Navarro project here, it's a suitable slope
calculation, and it's where slope is greater than 20 degrees. That last bit helps if we refine our criteria in the
future, say to 25 degrees, and I create additional data products, I don't confuse them or have something like
suitable_slope2 for lack of a better naming scheme. For your own projects, come up with your own naming
scheme that works for you, but I highly recommend something that has at least a little bit of detail!

Click run to see the result of the expression (4), then move the resulting raster into the Suitability group layer in
the Contents pane by clicking and dragging.
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13.2 Examine the slope output

Take a look at the resulting raster. Look at which areas have values of 0 (false) and which areas have values of 1
(true) - do these results make sense? Did we get the expression right for what we were trying to do?
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13.3 Do this three more times, but differently!

Let's now create the equivalent analysis grids for aspect, elevation, and coast distance. For each of these, we'll
run raster calculator again - think about what your expressions will be.

(1) Aspect Expression:

(“Inputs\navarro_aspect" > 225) & ("Inputs\navarro_aspect" < 315) 

The parentheses and ampersand let us chain two conditions here - so for the expression to be True both of those
conditions must be met

Consider why we might be using 225 and 315 as our filter values here - look at the symbology for the aspect data
for hints.

Output raster: Name your output navarro_suitable_aspect_225_315

(2) Elevation Expression:

("Inputs\navarro_dem_10m" > 50) & ("Inputs\navarro_dem_10m" < 250) 

Output raster: Name your output raster navarro_suitable_elev_50_250

Consider why we chose these numbers in the conditions before proceeding.

(3) Coast Distance Expression:

"Inputs\navarro_coast_distance" <= 35 

Output raster: navarro_suitable_coastdist_lte35

Why is the coast distance <= 35? Should it be <= 35,000 instead? Look at the symbology for
navarro_coast_distance to understand what value to use better.
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Do we need to do anything with the Old Growth Raster? Take a look at it and think what its data might mean.

Inspect each of these results and ask yourself if they make sense - confirm for yourself through visual inspection
that it appears we wrote the expression correctly based on what you expected the results to be (this makes sure
we move on with valid data and that you understand how this is supposed to work!). Move each of these
resulting items to the Suitability group layer before proceeding.
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13.4 One last, big raster calculation before retirement

Ok, now we have separate rasters for suitability, based on each parameter. We need to combine them into a
single raster indicating overall suitability for the species. If each raster habitat suitability raster uses 0 for
unsuitable and 1 for suitable, then what combination of these rasters gives us overall suitability? Recall that the
marbled murrelet needs *all* of these conditions to be met for suitable habitat - if any one of them isn't met, it's
not suitable and we want to discard it.

We're looking for the locations where all of the rasters have a value of 1, correct? That's where each suitability
requirement is met. To get a resulting raster indicating those locations, we'll again use raster calculator. In
previous expressions, we've used the & operator to chain requirements - saying multiple criteria must be met.
We'll do the same here. Once again, it's a question that raster calculator is answering for us ("where are these
requirements met?"), but it's written a little differently. Since 0 is always "false" and 1 is always "true" we can jut
chain together the layer names. For example, putting "navarro_suitable_coastdist_lte35" is equivalent to
"navarro_suitable_coastdist_lte35" == 1 in this instance. Knowing that, what does our full expression look like?

The expression you'll want to put in should be something akin to:

"Suitability\navarro_suitable_coastdist_lte35" & "Suitability\navarro_suitable_elev_50_2

Again, double clicking the layer names from the box instead of typing them will get the quoting correct for you,
but if you already know that you're using the correct quotes, go ahead and type it in. You can also copy and paste
the expression from here if you've kept all the layers moved to their correct group layers. Save the output in your
default geodatabase and name it navarro_suitability_marbled_murrelet
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14. Our final suitability map

You'll get another raster as a result, effectively answering the question of "where is suitable habitat for the
marbled murrelet" as the 0 and 1 value set we've seen before. Set the symbology for the unsuitable (0) values to
transparent, and the 1 values to something like a blue, then show it with just your DEM/Hillshade combination
below it (bottom image, below). Examine the locations. Does it seem like there are limitations to the analysis?
What are they? Does the habitat show up where you'd expect it to?
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14.1 Additional Considerations and ways to deepen the analysis

Questions
Examine your output. How do they differ from the Old Growth patches?
What about the quality of the patches, are there characteristics that might need further investigation? How

might we go about that?
What other data layers would be helpful to address this problem statement?
What other habitat related information could be generated from your identified nesting patches?
If this were a probability exercise, as opposed to presence/absence, which data might you use as weighting

terms?
Consider how we might have used raster functions to do some of these calculations - what would the

implications for our workflow be?

Suggestions for Additional Work
Suitability analyses are a deep area in GIS and a common need. You can use them as part of habitat analyses
like we just did, or for determining the location of critical infrastructure (transmission towers, fire lookouts),
siting a business, etc. There isn't one way to handle them, and more complex suitability analyses use weights for
each layer or probabilistic gradients rather than simple yes/no combinations. Consider how you could
accomplish something like this with raster calculator. ArcGIS also has tools for suitability analysis, such as the
Weighted Overlay tool that can support such analysis.

ArcGIS recently added the Suitability Modeler to handle more complex workflows and probabilistic calculations.
I've only just started playing with it, but if you think that locating the best (or worst) spot for something, or
identifying where something is likely to already exist, etc, is something you might spend more time doing, I'd
recommend exploring it. You can find it on the Analysis tab. The concepts you learned here will translate over,
but it gets more complicated very quickly. There's an entire help section on what the spatial modeler is, common
workflows, and how to use it at https://pro.arcgis.com/en/pro-app/latest/help/analysis/spatial-
analyst/suitability-modeler/what-is-the-suitability-modeler.htm
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